Thank you for purchasing an Epilog Laser or PhotolLaser Plus!

Epilog has teamed up with CADLink to bring you an exciting software package
for converting photographs for laser engraving applications. PhotoLaser Plus
software makes lasering photos a snap and is exceptionally easy to use.
Installation instructions and a brief tutorial are included below.

Because this software is not a full version of the CADLink EngravelLab software
we have compiled the information below to help you get started:

1)

2)

3)

4)

5)

Because this is not a full version of Engravelab, there are several key
components that are not included. The primary purpose of this software
package is to provide a very easy method of processing photographs for
laser engraving. There are additional features included with the software,
but only the photo processing features are supported by Epilog at this
time. For technical support on the software, please contact EngravelLab
directly at 1-800-545-9581.

This PhotolLaser Plus software is not intended to replace your other
graphic layout software such as CorelDraw or Adobe lllustrator. It is an
ideal software package for photo processing that provides a perfect
complement to your other software.

This limited version of PhotoLaser Plus does not qualify for an hour of free
training CADLink offers with their “Full” versions of software. Epilog
provides some short tutorials for processing photographs, but additional
training beyond our tutorials is not provided.

As time permits, Epilog will provide additional training tutorials for two of
the other exciting features included with this software — Serialization and
Badge Layout. Please access the Technical Library at www.epiloglaser.com
for updates.

You must have an Internet connection on the computer on which you
wish to install PhotolLaser Plus. The Internet is the only means of
activation.
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Installing EngravelLab PhotolLaser Plus DL Edition

Follow standard installation protocol for installing PhotoLaser Plus onto your computer.

During the installation process the 41 Default Palette —_— =x=)
Quick Start Guide for PhotolLaser Plus | (i) [/ « palettes » Engrave — - [+ | scarct A]
instructs you to choose a color ganize ~ HHf Views™= @
palette to use with your laser. hlercs Dtemockied || Type L
BE Desktop .| Debece.pal
i || GCCLaserEngraver.pal
. 5 | Linkmotion.pal
Unlike other lasers, you can use any g Boasent [ Trotec_CMYK.pal
H H Prctures | Trotec_RGB.pal
color palette with your Epilog system e Dete
and you can skip this step. Click on & RecentlyChanged | | |versalaserpalette.pal
Mare » | Xenetech.pal
Cancel to move to the next screen.
Folders A
File name: L | T
Save as type: | Palette Files(*.pal) v]
= Hide Folders Save Cancel

Engravelab Photolaser Plus DL initially installs as a demo version. In order to convert from the
demo mode, you must activate your product by connecting your PC that the software is
installed on to the Internet. The demo version will allow you to output 10 times before it must
be activated for use.

An Activation Pin was included with your purchase of PhotoLaser Plus. Until you activate your
software you can operate in demo mode and the following screen will be presented to you
each time you open Photolaser Plus:

EngraveLab PhotoLaser Plus DLD - Untitled1.CDL |

! E This is a dema version. You will have anly limited number of cuts available. To register please select 'Yes'. To continue working in demo mode please select o'
L3

To activate and register PhotoLaser Plus DL, select Yes. To continue running the product in
Demo mode, select No. Note that during the operation of the Demo, you can also access the
Registration page by clicking on the Help menu and then Register.

If you select Yes or click on the Help menu and then Register, the following web page will
display:
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Il \/eb Browser

[ Ix

ENGRAVELAB

PhotolLaser Plus

Register EngraveLab PhotoLaser Plus

If you wish to purchase a full working copy of Engravel ab PhotoLaser Plus or are having difficulty installing
your trial version, please contact your local reseller or CADIink at the following locations.

United States Canada Europe
500 Main Street 2440 Don Reid Drive Intech House, Wilbury Way
Clinton, MA, 01510 Ottawa, ON, K1H1E1 Hitchin, Herts, UK, SG4 0TW
Tel: 1-800-545-9581 Tel: 1-800-545-9581 Tel: ++44(0) 1462-420222
sales@cadlink com sales@cadlink com sales@cadlink co uk

Please fill in this form in order to unlock your copy of Engravelab Photolaser Plus.
Machine ID: 2919311664

Software Activation PIN: I

Company: I
First Name: I
Last Name: [
Street Address: [
Street Address (2): |
City: —
State/Prov: l—
Country: lm
ZiplPostal Code: [
Phone: l— ext l—
Fax: l— ps
E-mail address: I
i £ mait addenses | =

Fill out the Registration page including the Software Activation PIN number that was included
when you received your software. After filling out the Registration page, click on the Submit
button. The following window will display.

Installation x|

License file updated successfully, Engravelab Photolaser Plus DLD will now shiubdown,

Click on OK and PhotolLaser Plus DL will close. The next time you run Photolaser Plus DL, the
demo announcement screen will not appear. You will no longer require an Internet connection
in order to operate the software.

Page 3 of 11



After installing Photolaser Plus, go to https://www.epiloglaser.com/how-it-works/video/preparing-
photos-for-engraving-with-engravelab-photolaser-plus/.
e Download the Epilog Material Settings files that we created. These are .plr files and
need to be saved to your hard drive. These files provide custom material settings that
Epilog has created specifically for various materials such as wood, acrylic, etc. The
settings have been optimized so that your processed photographs will look as good as
possible when engraved with your Epilog laser.

e Save the files to C:/Program Files/EngravelLab Photolaser Plus/photolaser. There should
be other .plr files in this folder. If you can’t find the folder, search for .plr files and add
these Epilog files to that folder.

We’re now ready to set up a job and process a photograph.

Processing Photographs for Laser Engraving

Set Your Page Size p — -,
Plate Size ‘ -. ‘ EE

When you open Photo Laser Plus,
you’ll set your plate size. You have
two choices: size of the piece or
entire table size. You’ll see many of
the Epilog Laser system table sizes are
preset to the engraving table size.

|| — Origin Selection Orientation I

3
{* Partrait
em " Landscape

Current Selection:

You can also change your page size | Custom -]
later if you wish. E | "|

Dimensgions
Height:

ﬂx £.000 ﬂimh

p—H

| Resize objects propartionally

Advanced Cancel
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If you wish, you may also click the Advanced button to set up more customized sizes for

frequently run projects.

Orientation

" Landscape

Current Selection:

I Custam

|Ip

— Dimenszions
width: Height:

ﬁ Wj‘x Wﬂinch

[ Resize objects proportionally

u] | | Cancel

Add Guidelines

 Customize Plate List

| Create ahd Add new blark size

2'% 3" (24.00in = 36.00in)
3 4 (36.00in = 43.00in)
35 (36.00in = 60.00in)
4w 4" [48.00in = 48.00in)
43 8" [48.00in = 96.00in)

Add to List | Delete

118" =8.3" [11.80in > 8.30in)
M 12" [16.00in = 12.00in)
M 12" [18.00in = 12.00in)
M 12" [24.00in = 12.00in)
" 18" [24.00in % 18.00in)
w207 [24.00in % 20.00in)
" 18" [25.00in = 18.00in)
" 18 T2 N0in = 18 NN

Remawve From List

[ Display at start up [~ Plate Objsct

Engrave Transform Image View Options Help

To make photo layout easier,
add guidelines around the
edges of the page.

Right click on the screen to
open the Edit Guides tool.

Press the horizontal or vertical
button to add a guideline and
drag it to the edge of the

page.

I~ &dd parallel line at narmal ™ Lock Guides o
offzet
Cancel | .

Faint 1 -
Change
A Ir4.1?8 _I: in —g|
Delet
v[aze =i _ ek |

LabelFont | Deletedl |
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IE Engravelab PhatoLaser Plus - Untitled LCDL

|mport your |mage Eile Edit Layout Amange Engrave Transform Image View Options Help
Objecte- soo x 0000 e 2457 2| 100000 j/ G0
4105560 °%° viooo0 I osee2 2 100000 :[,

Select File/Import to import your

image. lr@aﬁié‘%‘l%“@‘i.ﬁﬁfﬂ

Resize it to the size you would like,

holding down the Alt key to keep the
proportions equal. The guidelinesin ']
the last step will help you position i
the photo and see what part of the ]
photo will be engraved. I

You can also specify the exact size
you want by typing in the size of the
photo at the top of the page. »

N

Change Image Appearance

[ £d|t Layout drunge Engrave Transform  [mage Dphnm Help
sinom 250 j” 1080 v Show Plate

3.533.5-1'3“ 5,0y 4768 :i t 1aam ¥ Show Substrate

If the file looks bitmapped when you import D

it, uncheck the “Show Reduced Bitmaps” B & B & & & & [0 {  scusimepouine

option under the View menu. ey e R S

¥ Show Tool Paths
Show Toel Paths Only

¥ | Shew Rulers

Show 3D

o

Lid T

Show Reduced Bitrmaps

Show Guade Labels
Palettes
Toolbars

Shew InstantReplay
Show Storage Bin

wt_“*-_r&l",‘\‘!.'!'k"/"

Page 6 of 11



Cropping the Photo _E e

iFlle Edit Layout Arrange Engrave Transform Image View Options Help

Not all photos need to be WMOO® [ #| e ||| WY ‘ ® | B & | [mo0tomslrestis]
cropped, but in cases where BN/ H & | &1 O [ fa| @ |sm: 3

you do need to crop the & B &G & \nc: [= % ®|ﬁ E = e u

photo, double click on the ' /—1=| et UL L L e
. [g., ] T

photo to open the bitmap :

tools at the top of the page. 7

Use the Rectangle or Ellipse
tool to create your crop area.
Use the Clip tool to finalize
the crop. We have found that
the Clip tool works better
than using the crop tool.

Set the Resolution

You will need to set the fmnge_Sgme Teniom mige Yiew Qpton: Hep
. eslution = mage File Size ¥ Maintain Aspect Ratio
resolution of your photograph H ﬁ 5 2 :::: W W |
to mat.ch the resolutlo.n you Y = {_,M “ E ﬁ @3 » ﬁ/@: fﬂ B <
are going to use for printing. = — e e L IS TR T

If you have a mismatch
between the photo resolution
and the printing resolution
your results may not look
acceptable.

To set the resolution, select
Image, Image Size from the
Menu Bar. Type in your
resolution, then select Apply
(pressing the Apply button is
very important as pressing the P oo bt
Enter key will not activate your change).

e Leave the Change Type drop-down box as Normal or it can take a long time to resize the
image.

e Onthe Legend Series: For wood, use 600 dpi. For acrylic and marble use 300 dpi.

e On the Zing Series: For wood use 500 dpi, and 250 for acrylic and marble.

Page 7 of 11



Process the Photo
With the photo sized, and the resolution set, we are ready to process the photo.
From the Menu Bar select Transform, Photo Laser. Chose Automatic to process photos using

the settings you used last, or Interactive if you want to choose a different material or if you
want to create custom settings.

E Engravelab Photolaser Plus - Untitled LCDL
File Edit Layout Arrange Engrave [Tlansfolm Image View Options Help

"Bitmap' #1 oo oy B247 Render to Bitmap

i[r-10.34?,0.928] B T" v 7EER Render Pattern Fill Bitmap
Contour Object...

EIY I YR .
— Photo Laser 3 Interactive...
ﬂr".|..'1'5...|...'1...|...D'5..|.| )

,I y Automatic

@ |-

a|

& |

{b ]

Choosing Interactive allows you to select a different material file. To select a new file, open the
Materials Folder by selecting the folder icon at the bottom-left side of the page.

Phaoto Laser - [Color Adjustments - me : g

To zoom infout press +/- ™ Keep Driginal
Filters | onjoff |~
i Histogram On
Edge On
Edge Off =
Threshold Off
Dither Off
Mixing Off |
Invert On
Flip Off i
Image In [ Resst i Image Out
— Histogram Black:
0
Gamma:
23
Channel:
| Master = I A & & ‘wéhite:
~Erd Limit f255
[
A Fay
ID 2585 ME—
| Reset l
& % | oK I Cancel |
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Select Your Material

There is a long list of materials to choose from,
but key points to remember are:

1) For wood use the
wood_setting_epilog.plr. This is for any
type of wood. This setting can also be

2)

3)

used for leather.

For marble, be sure to use the
marble_invert setting. This setting can
also be used for black anodized

aluminum.

For acrylic, use the acrylic_ invert setting

Look in: I | photolaser

>
Name

|| Leather-Smooth-Brown.plr
|| Leather-5mooth-Burgundy.plr
|| Leather-Smooth-Grey.plr
|| Leather-5mooth-Tan.plr
| maple.plr

| marble.plr

|| marble_invert.plr

|| paintedbrass.plr

| Sean.plr

| walnut hi detail.plr

| walnut.plr

| whtblkplst.plr

|| wood_setting_epilog.plr

G m

Date modified
3/26/2007 10:43 AM
3/26/2007 10:44 AM
3/26/2007 10:45 AM
3/26/2007 10:46 AM
11/3/2003 10:05 AM
11/3/2003 10:06 AM
5/18/2010 9:46 AM
10/30/2003 10:37 ...
4/21/2010 10:18 AM
4/6/200512:03 PM
11/3/2003 10:07 AM
10/30/2003 10:37 ...
5/5/2010 10:29 AM

File name: ]

»

to flip and invert the photo. This setting
can also be used for glass.

MPhoto Laser (*.piry

LJ Cancel |

These are settings we’ve created, so if you don’t see them, you need to download them from
www.epiloglaser.com/photolaserplus _instructions.htm. (See page 3 on where to save them).

FInISh ProceSSIng Photo Laser - [Color Adjustments - Levels] - [Color Adjustments - LEVE'SI“:,['EHB‘I'J. M

[~ Keep Original

N | On/Off
Histogram On
Edge On

To zoom infout press +/-

You can now preview the photo. There
are a variety of tools the software makes

. . . Ed Off
available if you want to adjust our _ Thieshold  Off
settings. These include histogram, edge, = il g
threshold, and more. <o o
Image In Reset Image Out
e If you want to keep both the Helogar e
original and processed photo [0
onscreen, you can check Keep Gg:f“mai
Original on this screen, otherwise St _
H H . Master A A& ‘wihite:
it will be replaced with the R =
[
processed photo. Iy %
e Press Okay and the window will [o &
Reset
close and take you back to your RS Bl

main page.
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Print to the Laser

And you’re ready to print to
the laser. i”

Remember to print using the
same resolution as your
photograph.

That completes the basic
process. Using the material
settings created by Epilog, you
can now easily produce
stunning photos onto wood,
acrylic and many other

0

"Bitmap" #1
[16.567 4.004]

@09253:?_

materials with a few clicks of
your mouse!

DY

ﬂ o 5,933
41 s

E wrveive s o M TR

File Edit Layout Arrange Engrave Transform Image View Options Help

2 100000y
§|| 100.000 éjz%

¢ oomo P

YRGS &b 0o s NED
j:_‘.--“---I---'2-..|‘..'3---|---2...|...“...,,,,E‘IHIHIB”

Additional Tips for Processing Photographs

Exporting to Corel

You cannot Copy and Paste your
converted image to Corel; you must
Export it as an .ai, ps file.

Go to File/Export and export the
file.

NOTE: Do not use the Export Image
option under the File menu. Only
use the Export option.

Use the Import command in Corel
to bring your processed photo into
your Corel page.

BR=N=3=M=

T Esport File
Save in: | , Phota Engraving Files
Mame Tags Size

=S

Date modified

i | TREE EXPORT ai

500 KB 6/7/2010 2:08 P

a4 L

4

File name:  |TREE EXPORT.ai

e

Save as twpe: |.-’-'l.dobe lustratar [* a7 ps)

Filter

[ Selected

. %Phota Engraving FileshTREE EXPORT. ai
File gize: BO3280

Created: Maonday, June 07, 2010

Lazt writter: Monday, June 07, 2010

Customize

ﬂ Cancel

v Preview
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Resizing in PhotoLaser Plus

We have found that resizing large digital photos sometimes leaves very faint artifacts. To avoid
these artifacts you may want to resize (Resample) your photo in CorelDraw, Photoshop or

Photo-Paint.

To Resample from Corel, select your photo and then go to Bitmaps and select Resample.

. CorelDRAW X4 - [Graphicl]

Help

& [ilé Edt  View Layout Arrange  Effects | Bimaps | Test Table Tools  Window

bR K ]

L

You can set your Image Size and
Resolution here, Export the photo as a
.jpg or .bmp image and then Import it
into PhotolLaser Plus for processing.

Resampling in Corel allows you to skip
the size and resolution steps in
Photolaser Plus. Simply Import and
process if you’'ve sized and set the
resolution of your photo in a different
program.

Canvert to Bitmap.,..

Auto Adjust
Image Adjustment Lab...

Straighten Image...

Edit Bitmap...

Bitmap Color [ask /
Eesample... Resamples the Bitmap h

AP,

Snapto - %E

E’ Trafe Bitmap

Mode »
Inflate Bitmap 3
Cunck Trace
Resample =
Irmage size
Height: 4.9 4.57 =10 (2 e
Resolution
Horizonkal: 200 &00] — dpi Identical values
Yertical: 200 600 = dpi
V| anti-alias
Original image size: 212 ME Lia
. . Maintain aspect ratio
Mew image size: 19,1 MB
[T maintain original size
[ (o] l [ Cancel ] [ Help ] [ Reset ]

Page 11 of 11




